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Version 20.1 Release Notes

This document provides important information about your Sage Estimating Essential 20.1 software. Read 
these release notes carefully before installing Sage Estimating Essential 20.1.

Welcome to Sage Estimating Essential!
Sage offers Sage Estimating Essential—a robust estimator's  toolkit—at a competitive price for small- to medium-
sized businesses. Sage Estimating Essential   blends ease of use with spreadsheet and standard database 
tools that enable you   to estimate jobs more productively and profitably. 

For even more versatility, it also integrates with the following, separately licensed, construction and accounting 
software: 

 l Sage 100 Contractor

 l Sage 300 Construction and Real Estate

 l eTakeoff

Read the Supporting Documentation Before You Begin

Read the following supporting documentation carefully before you install, configure, and use Sage Estimating 
Essential:

 l The Getting Started Guide provides an operational overview of the Sage Estimating Essential software. 

 l The Installation and Administration Guide includes a system overview, installation and configuration 
instructions, and information about managing your Sage Estimating license.

 l The Quick Start Checklist provides a list of tasks you need to perform to get Estimating Essential "up and 
running." You can use it to check off tasks as you complete them.

 l The Sage 100 Contractor Integration Guide describes how to integrate Sage Estimating Essential with 
Sage 100 Contractor, making certain data in that program available in Sage Estimating Essential, and it 
explains how to use the interface wizards to send proposals, budgets, and change orders you create in 
Sage Estimating Essential to Sage 100 Contractor.

 l The Sage 300 Job Cost Integration Guide provides installation, setup, and operating instructions for Sage 
300 Job Cost integration. 

 l The Means Integration Guide provides installation, setup, and operating instructions for Means 
Integrator. 
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Notes:  

 l For current information about supported operating systems, Internet browsers, Microsoft® 
SQL Server®, and other software, and about system requirements for servers and client 
workstations, refer to our Knowledgebase article ID 105383, available at 
https://support.na.sage.com/selfservice/viewdocument.do?externalId=105383.

 l All the documentation for Sage Estimating Essential is available at 
http://cdn.na.sage.com/Docs/en/customer/estimating/DocumentationEss.htm.

Video tutorials demonstrate how Estimating works!

Sage has created a series of video tutorials that demonstrate how you use Sage Estimating Essential. You can 
view them by clicking Help > Video Tutorials in the Estimating application.

Installation Notes

System Requirements

For current information about supported operating systems, Internet browsers, Microsoft® SQL Server®, and 
other software, and about system requirements for servers and client workstations, refer to our 
Knowledgebase article ID 105383, available at 
https://support.na.sage.com/selfservice/viewdocument.do?externalId=105383.

Installing Sage Estimating

Refer to the Installation and Administration Guide for complete instructions on installing the software and 
migrating or upgrading your data.

Before Installing 

Important!  

 l Microsoft .Net 4.6.2 is required for Estimating. If it is not already installed on your computer, the 
Estimating installation will require a restart. If you prefer not to restart when installing Estimating, first 
install .Net 4.6.2 from the Prerequisites folder (in the Install folder), and then restart your computer 
before installing Estimating.

 l If you are upgrading to version 20.1 and you are using third-party software that integrates with Sage 
Estimating, check with the third-party software vendor to ensure that their software is compatible with 
version 20.1 before you upgrade.
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We've been listening to you!
Sage thanks you for your product ideas! 

In Sage Estimating Essential version 20.1, we have incorporated the following customer request:

 l On the spreadsheet, you can now highlight and tag individual cells and groups of cells. 

You can use the cell highlighting and tagging feature in a multitude of ways during takeoff, pricing, and 
review. For example, you can highlight cells to mark start and end points, unusual items, changes, elements 
that represent an advantage in the bidding process, incomplete work, and more. 

Thank you, Bill B, for suggesting this enhancement!

The next section describes this enhancement in more detail. 
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New Features and Enhancements

Sage Estimating version 20.1 introduces the following significant features:

 l The ability to highlight and tag spreadsheet cells.

 l Improved, editable productivity and price factors.

 l Simplified setup and configuration.

 l Improved processes to import and export estimates.

It also includes a few miscellaneous improvements to simplify your use of Sage Estimating.

Highlight and tag spreadsheet cells 
On the spreadsheet, you can now highlight and tag individual cells and groups of cells. For example, you might 
need to adjust a calculated factor to reflect a sudden change in productivity, but you're not yet certain how to 
quantify that change. You know you'll need to revisit the factor after validating your assumptions, so you 
highlight the cell with a different color to set it off from other cells on the spreadsheet, and tag it to remind you 
about the information you wanted to validate.

To highlight cells:

 1. Select a cell or a group of cells that you want to highlight, and then right-click. 

 2. From the shortcut menu, click Edit Highlight.

 3. In the Highlight Color window, select a fill color for the cell or group of cells, and then click [OK].

After highlighting items on the spreadsheet, you can click the new [Show Only Highlights] (on the Home tab of 
the ribbon) to display only rows that include a highlight.

To tag a highlight for easy reference, later:

 1. Right-click a highlighted cell, and then select Tag Highlight from the shortcut menu.

 2. In the Set Highlight Tag cell, type a name to provide some significance to the highlight color (for example 
"Review factor override"), and then click [OK].

When you no longer need the highlight and the tag, simply right-click the highlighted cell (or select the group of 
cells, and then right-click them), and then click Clear Highlight on the shortcut menu. Or, you can right-click the 
Select All button (in the top left corner of the spreadsheet) and then click Clear All Highlights.
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Take advantage of improved, editable productivity  and price 
factors  
You can use productivity factors to adapt your estimates to a variety of challenges—such as adverse weather or 
environmental conditions, and other variables that can affect the efficiency of labor and equipment, as well as 
the price of materials, subcontractors, and other costs you use on a construction project.

In previous releases of Estimating (SQL), the program calculated labor and equipment productivity 
automatically when you entered prices and quantities. To change the calculated productivity, you could enter a  
different amount in the Productivity Adjustment columns—but then the program readjusted the productivity 
factor to 1.

With version 20.1, you have more control in defining productivity factors and determining productivity. You can 
enter productivity factors for labor and equipment directly, or you can have Sage Estimating back-calculate the 
factors for you based on the quantities and costs or prices that you enter. Similarly, you can edit price factors 
for material, subcontracts, and other costs directly on the spreadsheet.

For example:

 l In previous versions, when you changed the productivity or order quantity, Estimating calculated a new Base 
Productivity and set the Productivity Factor to 1.

In version 20.1, if you enter amounts that change productivity, Sage Estimating calculates a new Productivity 
Factor, leaving the Base Productivity unchanged.

 l Similarly, if you changed the price, Estimating used to calculate a new base price and set the price factor to 1. 

Now, if the price factor is not already 1, Estimating leaves the Base Price unchanged and calculates a new 
price factor.

New spreadsheet columns make productivity variables more explicit 

New spreadsheet columns expose base prices, quantities, costs, and cost per unit as follows:

Column Purpose

Base Cost per Unit This is the base amount divided by the takeoff 
quantity. Also called Base Unit Cost.

Base Price The amount paid or asked per order unit for an 
item category before applying any price factor.

Base Price Unit This is the unit description for the base price 
(the same as order unit).

Base Quantity Either the takeoff quantity (with waste) 

New spreadsheet columns
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Column Purpose

(for labor and equipment) multiplied by base productivity, or the takeoff 
quantity (with waste) divided by base 
productivity.

Base Quantity Unit 
(for labor and equipment) 

This is the unit description for the base quantity 
(the same as order unit).

Note: You may need to edit your current layout to display these columns.

Change base amounts, productivity, and factors directly

In version 20.1, you can edit the following columns that previously you could only view:

Column Purpose

Base Amount This is the order quantity (including productivity factor) multiplied by the 
base price.

Base Productivity This value is used to change takeoff quantities to order quantities for labor 
and equipment. It does not include the productivity factor.

Price Factor This value is used to increase or decrease the base price per item category 
to reflect local pricing.

Productivity Factor (for 
labor and equipment)

This value is used to increase or decrease the base productivity per item to 
reflect local working conditions.

Newly editable columns

Note: These changes apply to units of labor and equipment usage only. Unless the order unit is a unit of 
time, the Productivity Factor is always 1, and you cannot change it.
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To help make productivity calculations more explicit, we have renamed some spreadsheet columns, as 
follows:

In previous versions In version 20.1

Productivity Adj Productivity Factor (for labor and 
equipment)

Conv Factor Conversion (for material, 
subcontracts, other)

Conv Factor Unit Conversion Unit  (for material, 
subcontracts, other)

Comparison of column names

Also, throughout the program, references to City Cost Index or CCI have been renamed Factor Table and 
Factors.

Tip: If you change an amount that affects labor or equipment productivity, or if you change a productivity 
factor directly, Estimating inserts a comment for the cell. Cells that have comments are marked by a red 
triangle in the upper right corner. To view a comment, simply hover over the marked cell. Comments 
include the original value and, if appropriate, the percent change. 

For more information, see the Estimating help.

Adjust productivity quickly during assembly takeoff

Adjusting productivity for labor and equipment during assembly takeoff has never been easier!  Rather than 
right-clicking a  column in the assembly takeoff grid, and then selecting Adjust Assembly the shortcut menu, 
now you can simply click a new [Adjust Productivity] button after adding a pass that includes labor and 
equipment. 

After entering your productivity adjustment in the Adjust Assembly Productivity window, assembly components 
that include labor or equipment are marked with a red triangle, indicating that the quantity has been adjusted. 
When you're satisfied that the adjustment is correct, finalize it by right-clicking the cell, and then clicking 
Finalize Adjustment on the shortcut menu.

Preserve custom factors when you apply a factor table 

If you adjust productivity or price factors manually for individual line items in an estimate and then apply a 
factor table to the estimate in the Estimate Information window or in the Reprice from Factor Table window, 
Estimating replaces them with new values derived from the factor table, unless you specify not to alter custom 
factors when you apply a factor table. 
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To retain custom factors:

In the Options window, select the Do not reprice prices and factors marked as manually adjusted option.

When this option is selected, you can mark manually adjusted factors on the spreadsheet.

You can adjust a factor manually in the following ways. 

 l Type a new value in the factor cell.

 l Use the shortcut menu to adjust the value (right-click the cell, click Adjust, and then adjust the value).

After adjusting a factor manually, a red triangle appears in the top right corner of the factor cell. 

When you are satisfied that the factor value is correct, you finalize the adjustment by right-clicking the cell, and 
then selecting Finalize Adjustment from the shortcut menu. The red triangle is replaced by a green triangle, 
indicating that the adjustment is final. The program automatically marks the factor as manually adjusted

To mark factors as custom factors that should not be overwritten when you reprice the estimate, you right-click 
the cell, and then select Mark Manual Factor from the shortcut menu. 

Simplified setup configuration.
We reorganized the Configuration Wizard to make it easier use. We renamed the fields and buttons on the 
Licensing tab so that it is now more clear how to select a license type and connect to a license server.

Improved import and export of estimates in the Estimating 
Management Console and the Manage Estimates window
The most significant change to the import and export processes occurs "under the hood," during the export 
process, which now includes branch information in the estimate export file. Because of that change, additional 
functionality is available during the import process. 

When selecting files to import from the exported estimates file, you can see the branch structure used in the 
export file. You can duplicate that same structure when you import the estimates, or you can import all the 
estimates into a single node or branch in the catalog by selecting a new Ignore branches from the exported 
estimates file option. 

In addition, a new Import Progress window informs you about the progress of your import and lists the status of 
imported estimates.  If you import an estimate that has the same name as an existing estimate in a branch, the 
import process now renames the imported estimate by appending a number to the estimate name. The Import 
Progress window displays imported estimates in a list, including their new branch location and  (if an estimate 
was renamed during the import process) the new name. 
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Example: Copy the structure from the export file
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Result:

Example: Ignore the structure in the export file

Result:
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We've also simplified the Import and Export windows, as follows:

 l We've renamed these windows Import Estimates and Export Estimates, identifying the purpose of the 
windows more clearly. 

 l The toolbar in the Estimate Catalog includes new Import estimates and Export estimates icons ( ). 
You no longer need to right-click the node, and then select Import or Export from the shortcut menu—you 
simply select a node in the catalog, and then click the Import estimates or the Export estimates icon on the 
toolbar. 

Note: We removed the Import estimates and Export estimates buttons from the ribbon in the Manage 
Estimates window, now that the new icons are available on the toolbar.

 l We moved the details about a selected export file to a separate window. You open that window using a new 
[Details] button. 

 l In previous versions, the Export Estimates window included an [Open Folder] button, which function was 
eclipsed by the more versatile [Browse] button. Now, only fully functional fields are included in this window, so 
you are not distracted with less important information or duplicate functions. 

Miscellaneous improvements
 l We have simplified the New Estimate window, with clarified instructions to help you create new 

estimates with ease.
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 l A convenient new Live Chat icon on the ribbon brings you directly to Sage Chat where you can chat with a 
Support analyst. (Previously, Live Chat was accessible only from the Help menu under Sage Support.)

 l New shortcut keys are available in the spreadsheet. 

You can display tabs quickly by pressing Alt together with the key for the first letter of the tab. For example, to 
display the Takeoff tab, you would press Alt + T. With these keys pressed, you can press one of the Key Tips 
that appear on the ribbon to open the corresponding function or window.
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Fixes Since the Previous Version

Version 20.1 includes the following fixes:

 l In the spreadsheet:

 l Columns are inserted correctly when you place them at the end of a spreadsheet row. 

 l On the spreadsheet report, the font for zero amount items appears correctly when on 4K and other high-
resolution monitors. 

 l In the Takeoff window, the Goto function selects the correct phase and item even if the list is collapsed. 

 l In the spreadsheet, the WBS tooltip shows the description for the WBS code, rather than the value. 

 l In the Bid Grid, amounts are calculated correctly when you toggle between a subcontractor and self-
perform. 

 l The Bid Grid report no longer skips subcontractors. 

 l Information in the Alternate Summary pane now scrolls correctly when the pane is docked. 

 l We fixed some display issues that sometimes occurred with 4K monitors. 

 l In notes for variables, the Enter  key works properly. 

 l In the Import Estimates pane, if you try to paste an invalid path to an import file, the program warns you by 
highlighting the background of the location text box and displaying a large red dot beside the box. 

 l If you install SQL Express when you install Estimating, the SQL installation uses the correct settings for 
shared memory and named pipes.

 l We have improved performance when you use your mouse in a large estimate that has combined items. 

 l If you try to create an estimate that exceeds the capacity of your SQL database, you receive a message 
telling you that the estimate exceeds the maximum size.  

 l You can rename items that you have copied into the spreadsheet, as expected. 

 l The Dimensions context menu on selected quantities once again opens the Enter Dimensions window. 

 l Miscellaneous fixes:

 l We have improved performance when you edit WBS values with a large number of rows. 

 l In the Database Editor:
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 l The Database Editor displays descriptions properly for WBS columns. 

Note: Because a layout can be used for multiple standard databases, the Database Editor and layouts 
now use the column name from the WBS code record. You cannot rename WBS columns except by 
changing it in the WBS code record.

 l Performance is not seriously impaired when you delete a very large number of items. 

 l You can check out a standard database that has duplicate WBS values.

 l If you collapse group phases in the Phases pane, the items grid refreshing properly when you select the first 
group phase after selecting another group phase.  

 l You can select non-contiguous cells in the Items grid by holding down the Ctrl key while you make your 
selections. 

 l You can drag and drop a column on the left side of a divided column, even if the column to the left of the 
dropped column is hidden, Previously, if the column to the left was hidden, the dragged  column would drop 
on the right side of the divided column.

 l The Replace function no longer skips cells that precede the active cell when you replace characters in 
several cells (such as a row or a column). 
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 l With productivity factors:

 l In Assembly Takeoff, you can view tooltips when adjusting productivity. 

 l When you use the Reprice from Factor Table window to restore base prices to an estimate to which a factor 
table was applied, you see only one confirmation dialog. 

 l For Sage Estimating reports:

 l In the spreadsheet report and the standard estimate report, the signature block reports the correct amount 
even if you round quantities and combine item.  

 l The correct information appears on the Spreadsheet report when you print it in takeoff order. 

 l Audit Action headings print correctly on the Takeoff Audit report. 

 l In the Estimating Management Console:

 l The Copy Database tool in the Estimating Management Console creates unique copies of source 
databases.

 l Migrating an Estimating (Pervasive) address book to an existing Estimating (SQL) address book no longer 
triggers errors for some addresses, if the address books are not synchronized. 

 l You no longer receive an error message when upgrading standard database item list sort orders. 

 l For Job Cost Integration:

 l When exporting to Job Cost, you can choose to continue exporting if the export process finds duplicate 
WBS values. 

 l When inserting a one-time addon for an estimate, you can close the Job Cost Options window properly after 
selecting a job cost phase.  

 l When you export extras to Job Cost, Estimating sends WBS descriptions and values as expected.)

 l When you import jobs from Job Cost, the import process creates cost codes before you begin importing. If 
there are errors in the cost codes, you can choose to fix the errors during the import without stopping the 
import process. 

 l Cost codes from Job Cost are properly formatted and displayed on overlines.

 l You are no longer required to include cost codes when you export markups and addons to Job Cost. 
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 l For the integrations with Dimension and Bridge

 l When you copy an item that came from Bridge, the copied item no longer appears to have come from 
Bridge also. 
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Revisions to Version 20.1

This section describes enhancements and fixes we have included in revisions to the software since releasing 
version 20.1. 

Note: Each update is cumulative. That is, each successive update includes all the fixes and 
enhancements provided in previous updates as well as additional fixes and enhancements in the current 
update.

Update 6 (Build 20.1.2204.282, April 2022)

Fixes

Update 6 includes the following software fixes:

 l We fixed a problem that could prevent you from installing a standard database.

 l You don't receive an error when you preview and print Crystal reports.

Update 5 (Build 20.1.2112.081, February 2022)

Fixes

Update 5 includes the following software fix:

 l Means Integrator warns you if the *.MIMX file is incompatible with your version of Estimating. 

You can update Means 2022 files in Means Integrator.

Update 4 (Build 20.1.2101.251, January 2021)

Fixes

Update 4 includes the following software fixes:
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 l After upgrading, columns that were hidden in saved spreadsheet and report layouts remain hidden. Base 
Price columns are not automatically turned on if they were not visible in the saved layout. 

 l You can duplicate estimates that include "quick sorts" on columns. (These are any columns that you right-
clicked, then clicked Sort Ascending or Sort Descending on the shortcut menu.)  

Update 3 (Build 20.1.2011.062, November 2020)

Fixes

Update 3 includes the following software fixes:

 l You can import estimates that include "quick sorts" on columns. (These are any columns that you right-
clicked, then clicked Sort Ascending or Sort Descending on the shortcut menu.) 

 l In Database Editor, you can now import prices for items that are selected as default takeoff items in 
assemblies.

Update 2 (Build 20.1.2010.063, October 2020)

Fixes

Update 2 includes the following software fixes:

 l The Means Integrator now skips modified City Cost Index tables in the standard database and updates the 
national average correctly. 

 l Estimating no longer warns subscription customers before the expiration date that their subscription is 
expiring. 

 l When you use the Clear Sort option in the shortcut menu, Estimating now clears the sort properly. 

 l When you adjust a total in the spreadsheet, and then undo the adjustment from the shortcut menu, Estimating 
restores the overline value properly. 

Update 1 (Build 20.1.2007.152, July 2020)

Fixes

Update 1 includes the following software fix:

 l When you import multiple estimates from a group of estimates that you exported together in a previous 
version of Estimating (SQL), all the estimate information is imported correctly.
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If you imported estimates from a group of exported estimates before this update, follow the steps outlined in 
Knowledgebase article 105869 to fix the imported estimates. 
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Known Issues

SAP Crystal Reports compatibility with other Sage programs
Sage Estimating version 20.1 uses the SAP Crystal Reports Runtime version 13.0.22, which is compatible with 
Crystal Reports Sage Fixed Assets 2018.1, and later. 

Do not use earlier versions of Sage Fixed Assets on the same computer as Sage Estimating. 

For more information, see Knowledgebase article KB 93436.
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Need help?

Get help by: Recommendation* To access:

Reviewing in-
product help

View information 
about the current 
window as well as 
procedures for using 
Estimating.

Click the Help button or icon, or press [F1] to display the 
Help topic for that window.

Reading product 
documentation  

View documents and 
reference material 
from the Estimating 
Product Documents 
website.   

Visit 
http://cdn.na.sage.com/Docs/en/customer/estimating/
DocumentationESS.htm

Searching the 
Knowledgebase

Search the Sage 
Knowledgebase, 
which provides 24/7 
access to support 
articles as well as the 
latest software 
downloads and 
updates.

Visit the Knowledgebase at www.sageKB.com

Asking the 
community

Join industry peers, 
certified partners, and 
Sage pros online 24/7 
in Sage City—the best 
place to ask questions 
and share product 
experiences, tips, and 
tricks.

Visit the General Estimating forum at www.SageCity.com 

Checking the 
latest product 
alerts

Keep up with the latest 
product information in 
the Sage City 

Visit www.SageCity.com 

How to Get Help
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Get help by: Recommendation* To access:

Announcements, News, 
and Alerts forum.

Exploring training 
options

Learn how to harness 
the full power of your 
software through 
videos and classes at 
Sage University.

Visit www.SageU.com
You can also get access to Sage University from the 
Estimating File menu by selecting Help  > Sage University.

*Not all options are available for all products. 

Submitting Enhancement Requests
We want to hear your suggestions for improving the software. To send us your comments, click on the File 
menu button  and then select Help >  Submit Product Idea.
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